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OVERVIEW

This User Guide describes how to access, view, and if it is required, accept or reject Purchasing Documents

(Contracts, Purchase Orders, Services Orders, Master Agreements, etc.)

HOW TO USE THIS USER GUIDE

If familiar with the iSupplier Portal Functionalities and the CRC processes, refer to the One-page Quick Reference

(Cheat sheet) on page 2. Otherwise, review the Process Overview section to better understand the processes.

Next, review the Content/Checklist section, as this section lists the required and optional steps for each of the

processes. Last, complete the required steps according to the detailed written instructions which follow the

numbering sequence shown in the screenshots for how each of the tasks shall be executed.

When completing the steps in the iSupplier Portal, you may refer to the Content/Checklist column to validate that

the required steps have been completed. In addition, this User Guide provides high-lighted and / or framed notes.

These are tips and important messages to assist you in some tasks.

PROCESS OVERVIEW

Purchasing Documents (Contracts, Purchase Orders, Services Orders, Master Agreements, etc.) can be physically

signed or electronically accepted in the iSupplier Portal by the Supplier.

Option 1: Purchasing Documents requiring a physical signature.

If the Purchasing Document required a physical signature from the Supplier, once the signed document is received

by CRC, the CRC Buyer will enter the Purchasing Document in to the CRC system and the Supplier will receive an

automatic email notification (i.e. Sender: “CRC-Notification” - Subject: “For Your Review – Standard Purchase

Order XXXXXXXXXX, X) indicating that the document is available in the iSupplier Portal. Optionally, Supplier can

access and view the Purchasing Document and related documentation in the iSupplier Portal.

Option 2: Purchasing Documents requiring electronic acceptance

If the Purchasing Document is issued to the Supplier electronically, the CRC Buyer will create the Purchasing

Document and the Supplier will receive an automatic email notification (Sender: “CRC-Notification” - Subject:

“Standard Purchase Order XXXXXXXXXX,X requires your acceptance) requesting acknowledgement and acceptance

of the Purchasing Document through the iSupplier Portal. Supplier shall access the portal and accept or reject the

Purchasing Documents by the required due date. Reminders are sent until the action is completed.

Option 3: Purchasing Documents to support invoices created from Supplier Charges (Field Tickets or Invoices)

Once an Invoice and/or a Field Ticket submitted through the iSupplier Portal is approved; the system automatically

creates and closes a Standard Purchase Order (SPO) against the Global Blanket Purchasing Agreement to support

the approved invoice. They can be identified through the standard naming convention populated in the

Description field (i.e. INV#-XXXXX). No notifications are sent to the Supplier. Supplier can view these Purchasing

Documents in the iSupplier Portal (Directly go to Section 2 Access the iSupplier Portal).
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Purchasing Document related transactions such as shipments, receipts, invoices, payments and attachments can all

be viewed in the iSupplier Portal.

Follow the steps outlined below to complete the required actions.
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QUICK REFERENCE (CHEAT SHEET)

1. Receive Notification
IMPORTANT: An email Notification will inform the
Supplier that they can review the Purchasing Document
or may require that they electronically accept or reject
the Purchasing Document within the portal.

2. Within the email Notification, click on the “iSupplier
Portal” hyperlink to be taken to the iSupplier Portal
“Login” webpage.Login to the iSupplier Portal

• In the “Main Menu” panel, click on the appropriate
responsibility.
 To acknowledge and accept or reject the Purchasing

Document, click on the “Supplier User –
Transaction” hyperlink.

 To view the Purchasing Document you can either
click on the “Supplier User – Transactions”,
“Supplier User – Full View” or “Supplier User –
Finance View” hyperlink.

• From the “Home” page, click on the “Order” tab.

3. Search for the Purchasing Document
• Click on the “Purchase Order” hyperlink.
 To display only the Purchasing Documents that

required review and acknowledgement, select the
option “Purchase Orders to Acknowledge” from the
“View” dropdown menu, and then click on the “Go”
button.

 As needed, click on the hyperlinks to access specific
details.

• Click on the specific “PO Number” hyperlink to access
the Purchasing Document details including both header
and line information, such as Terms and Conditions,
Lines, Shipments and Attachments.
 The “Status” column will indicate Requires

Acknowledgement for those Purchasing Documents
that need to be electronically acknowledged and
accepted/rejected.

4. Review the Purchasing Documents Details.
• Review the “Order Information” section
 In the “Attachment” field, click on the “View”

hyperlink. Then, click on every file name hyperlink
in the “Title” column to view the Purchasing
Document as well as all related attachments.

Note: Any contractual documents are categorized as
“Contract” in the “Category” column.

• Review the “PO Details” section
As needed, view details for a particular line by clicking on
the “Show All Details” hyperlink to access the pricebook
information.

5. Electronically Acknowledge and Accept or Reject
the Purchasing Document.

• Select the option “Acknowledge” from the “Actions”
dropdown menu, and then click the “Go” button.

• Click on the “Accept Entire Order” or the “Reject Entire
Order” button.
IMPORTANT:
 By accepting the Purchasing document, the Supplier

is agreeing that the Purchasing Document details
are correct and accepts the offer contained in the
Purchasing Document, creating a binding
agreement.

 By rejecting the Purchasing document, the Supplier
is communicating that they do not accept the offer
contained in the Purchasing Document. Changes to
the Purchasing Document can be requested
through a note to the buyer. The buyer will either
revise the Purchasing Document or cancel it.

• As needed, send a message to the buyer in the “Note to
Buyer” field.

• Click on the “Submit” button, and then click on the
“Return to Purchase Order Summary” hyperlink to
return to the main screen.

6. Additional transactions related to Purchasing
Documents.

• View transactions associated with the Purchasing
Documents such as shipments, receipts, invoices and
payments.
 Access a specific Purchasing Document.
 From the “Actions” dropdown menu select the

transaction to be viewed, such as “View Receipts”,
“View Invoices”, “View Shipments” or “View
Payments”. And then click on the “Go” button.

• View the revision history of a Purchasing document.
 Click on the “Orders” tab, and then click on the

“Purchase History” hyperlink.
 Populate the search criteria, and then click on the

“Go” button.
 As needed, click on the hyperlink to access specific

details.
 Click on the appropriate icons to view the

comparison among the versions of the Purchasing
Document.

• Access the agreements related to a specific Purchasing
Document.
 Click on the “Orders” tab, and then click on the

“Agreements” hyperlink.
 Populate the search criteria, and then click on the

“Go” button.
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 As needed, click on the hyperlinks to access specific details.

CONTENT / CHECKLIST

Steps
Page

No
Required Check

1. Receive Notifications 5 Required

1.1. Notifications Type 5 Required

1.2. Received Notifications - Details 6 Required

2. Access the iSupplier Portal 8 Required

3. Search for Purchasing Documents 9 Required

4. View Purchasing Documents Details
4.1. Header Information
4.2. Line Information – PO Details Section

4.2.1. Shipment Information – Applicable to SPO or BR only
4.2.2. Price Break Information – Applicable to GBPA or BPA only

4.3. Electronically Accept or Reject Purchasing Documents (only for
Purchasing Documents Requiring Acceptance)

4.4. View Related Transactions to Purchasing Document
4.5. View Purchasing Document History – Revision Details

10
10
13
13
14
14

17
17

Required

5. View Orders Related to Specific GBPA / GCPA
5.1. Standard purchase orders related to GBPA / GCPA or blanket

releases related to BPA

18
19 Required

EXHIBITS

1. Purchase Order View Columns 20 Optional

2. PO Header Information 21 Optional

3. PO Details
3.1. PO Details – Line Information
3.2. PO Details – Shipment Information
3.3. PO Details – Price Break Information

22
22
24
25

Optional

4. Purchasing Document Types 26 Optional

5. Line Types 27 Optional

6. PO Status 27 Optional
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INSTRUCTIONS

1. RECEIVE NOTIFICATIONS

1.1 NOTIFICATION TYPES

After an CRC Buyer issues a Purchasing Document, the Supplier will receive an automatic notification. A Purchasing

Document is either handled electronically through the iSupplier Portal or physically signed and uploaded to the

portal by CRC. Suppliers can receive notifications for the following subjects:

Case Subject Subject Example Supplier Action

Option 1
(Purchasing
Documents
requiring a

physical
signature)

For Your
Review –
Contract
Type
XXXXXXX
XXXX,0

Optionally,
View the
Purchasing
Document
within the
Portal.

Option 2
(Purchasing
Documents

requiring
electronic

acceptance)

Contract
Type –
XXXXXXX
XXX,0
requires
your
acceptan
ce
Supplier
Action

Mandatory,
View and
accept or reject
the Purchasing
Document
within the
Portal.

IMPORTANT – Option 3: Purchasing Documents to support invoices created from Supplier Charges (Invoices
and/or Field Tickets). No E-mail Notification will be sent. No action is required from the Supplier. To view the
related Purchasing Documents, directly go to Section 2 Access the iSupplier Portal.

NOTE: For further information regarding Notifications, please review the User Guide – Overview Access and
Passwords, Navigations and Notifications.

IMPORTANT: For automatic notifications the email sender will be “CRC – Notification” not a specific CRC Buyer. If
you do not receive a notification in your mailbox, please check your mailbox spam, trash or delete folders, or see
if it might have been filtered by your company spam filtering services. Make sure to set “CRC – Notification” as a
valid email sender to avoid any issue for subsequent notifications. Yahoo and Hotmail email account users might
NOT receive some notifications correctly. If an email notification contains an error message, contact the CRC
Buyer or Supplier Help Desk.
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1.2 RECEIVED NOTIFICATIONS - DETAILS

Both types of notifications are formatted in the same way, whether they require a review of the Purchasing

Document or the acceptance or rejection of the Purchasing Document within the portal. The notifications show the

following information:
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( 1 ) The Email Subject displays the Purchase Order number, the type of notification and required action.

( 2 ) View the type of action to be taken and the due date for the response.

Type Action to be Taken

Option 1 View the Purchasing Document within the Portal

Option 2 View and accept or reject the Purchasing Document within the Portal

NOTE: The example above shows an order that requires acceptance. This means that Supplier must review and
accept or reject the Purchasing Document within the iSupplier Portal.

( 3 ) The notification allows access to the iSupplier Portal by clicking on the iSupplier Portal hyperlink.

NOTE: This hyperlink will take you to the iSupplier Portal “Login” webpage

( 4 ) The Quick Reference hyperlink allows access to the instructions to perform the required action.

( 5 ) The Note to the Supplier shows any clarification written by the buyer.

IMPORTANT: This field can contain specific instructions for the Supplier.

( 6 ) The Buyer Contact Data field displays the name of the CRC Buyer who has sent the notification.

( 7 ) The Header section displays the Supplier’s information including ship-to and bill-to addresses

( 8 ) The Summary section displays the Purchase Order Number, the Date of Order and the Buyers Name.

( 9 ) The PO Details section displays the specific line information for the Purchasing Document.

NOTE: See additional details about each column in the section 4 - View Purchasing Documents Details

( 10 ) DO NOT click on the Actions button in the notifications. To accept or reject the documents you must do so

through the iSupplier Portal.

IMPORTANT: Save the Purchase Order Number to use when performing a search for the document in the
iSupplier Portal.
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2. ACCESS THE ISUPPLIER PORTAL

Login to the iSupplier Portal at: https://supplier.californiaresources.com/OA_HTML/AppsLogin

( 1 ) Enter your Username and Password and click on the Login button.

NOTE: The Password field is case sensitive. If there is a problem accessing the iSupplier Portal, click on the Login
Assistance hyperlink. Alternatively, view the User Guide– Overview Access and Passwords, Navigation,
Notification.

After logging in to the portal, the Oracle Application Home Page will be displayed if more than one responsibility is

assigned to the user. If the User only has one responsibility the Home tab screen for that responsibility will

automatically be displayed.

( 1 ) According to the action to take, click on one of the following responsibilities to access, view and, if required,

accept or reject the Purchasing Document(s).

Supplier Action Needed Responsibility

View the Purchasing Document within the
Portal.

Supplier User – Finance View
Supplier User – Full View
Supplier User – Transactions
Supplier User – Invoicing*

View, acknowledge and accept or reject the
Purchasing Document within the Portal.

Supplier User - Transactions

NOTE: (*) Supplier User - Invoicing responsibility is assigned by CRC to selected suppliers that invoice through the
iSupplier Portal.

Once in the required responsibility, the Home tab screen for that responsibility will then be displayed.

NOTE: If none of these responsibilities have been assigned to you, contact the iSupplier Portal Security
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Administrator within your company to request them. Go to the User Guide – Overview – Access and Passwords,
Navigation and Notifications to learn how to view the list of your company contacts and iSupplier Users.

3. SEARCH FOR PURCHASING DOCUMENTS

There are two options to search for and access a specific Purchasing Document. First is through the Home tab

Search functionality and the second is by accessing the Orders tab.

Option 1 – Search from the Home tab

( 1 ) In the Search section, click on the Search dropdown menu and select PO Number.

( 2 ) Enter the Purchase Order Number in the text field and click on Go button. The Purchase Order screen in the

Order tab will appear with the corresponding documents. See next option for further details.

Option 2 – Search from within the Orders tab

( 1 ) In the iSupplier portal Home screen, click on the Orders tab.

( 2 ) Click on the Purchase Orders hyperlink to search for and open Purchase Orders.

( 3 ) Under the Views section, Supplier may select from the View dropdown menu the applicable option to display

the Purchasing Documents, and then click on the Go button or click on the Advanced button to narrow down

the search criteria.

Option Description

All Purchase Orders The system displays all the Purchase Orders.

Purchase Orders to Acknowledge The system displays only the Purchase Orders that require
acknowledgement from the Supplier.

Purchase Orders Pending Supplier Change Option disabled.

( 4 ) The Export button allows the Supplier to export all of the general information for the Purchasing Documents

to a spreadsheet.
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( 5 ) The columns provided under the View screen assist the Supplier in defining which PO to access. For a detailed

description on each of the columns listed, see Exhibit 1.1 Purchase Order View Columns.

( 1 ) Identify the Purchasing Document and click on the applicable PO Number hyperlink to display the detailed

information about the Purchasing Document.

4. VIEW PURCHASING DOCUMENT DETAILS

The Purchasing Document Details screen displays detailed information related to all sorts of Purchasing
Documents such as the Purchase Orders, Contract Agreements, Standard Purchase Order Supplier Charges, etc. As
well as information such as the ship-to and billed-to address, terms and conditions, shipments and related
attachments. The screen is split into 2 sections; Header and Line information.

4.1 HEADER INFORMATION

The header information provides the key Purchasing Document information.
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The header of the webpage displays the Document Type (e.g. Standard Purchase Order, Global Blanket Purchase

Agreement, etc.) and the Document Number (e.g. 21000002123)

IMPORTANT: For a detailed description on each field displayed, see Exhibit 2 PO – Header Information.

( 1 ) The Order Information section displays general information and terms about the Purchasing Document, i.e.

Supplier, Description, Status, Purchase Document Type, Payment Terms, Ship-To and Bill-To Address.

( 2 ) The Summary section displays the transaction information, i.e. Total, Received, Invoiced and Payment Status.

NOTE: GCPAs do not have a Summary section.

( 3 ) The Attachments field displays attachments included with the Purchasing Document. Click on the View

hyperlink to review the signed physical contract or the electronic document to be accepted or rejected; as well

as all related attachments. Then, the following table will appear:

 Case 1: Electronic Purchasing Documents.

 Case 2: Physically signed purchasing contract. The Attachment table shows the scanned copy of the

signed terms and conditions as it appears in the screenshot below.

( 1 ) From either of the cases above, view, save or print the document by clicking on the Attachment Name

hyperlink under the Title column.

( 2 ) The Category column shows the type of attachments.

NOTE: The actual Purchasing Document that has been signed as well as related contractual documents are
categorized as Contract.

IMPORTANT: To allow iSupplier Users to view and print the Purchasing Document with the terms and conditions,
the Buyer needs to attach the document in the Attachment Section. If the document is not available, request that
the appropriate Buyer attach the documentation. If the Purchasing Document has a signed physical contract, a
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scanned copy of the signed terms and conditions will be included as an attachment.

( 1 ) Click on the Open or Save button to view the document. Then, the original Purchasing Document will be

displayed.
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4.2 LINE INFORMATION - PO DETAILS SECTION

The line Information provides the specific detailed data of the services and/or materials requested by CRC.

IMPORTANT: This section is applicable to Global Blanket Purchase Agreements, Standard Purchase Order, Blanket
Purchase Agreements and Blanket releases. Global Contract Purchasing Agreements (GCPA) does not have lines.
For a description on each of the fields displayed, see Exhibit 3.1 PO Details – Line Information.

( 1 ) Under the PO Details section, the specific line information is displayed. This includes information such as the

Line number, Line Type, Description, Quantity, Price, Amount, etc. Verify the information entered is correct.

For additional information, see Exhibit 3.1 PO Details – Line Information. According to the PO Type the system

will display one of the following:

 Shipments Information (only applicable to Blanket Releases or Standard Purchase Orders). Go to step

4.2.1 Shipment Information.

 Price Break (only applicable to Global Blanket Purchase Agreements. Go to the Step 4.2.2 Price Break

Information.

4.2.1 SHIPMENT INFORMATION – ONLY APPLICABLE TO SPO OR BR

Shipment Information is defined for each line ordered through Blanket Releases (BR) and Standard Purchase
Orders (SPO).

IMPORTANT: For a description on each fields displayed, see Exhibit 3.2 PO Details – Shipment Information.

(1) Click on the Show All Details hyperlink to view all line details or click on the Show hyperlink to view a
specific line.

(2) The system will display details such as the Ship-To- Location, Quantity, Amount, Promise Date, Need By
Date, etc. Verify the information provided is correct. For additional information, see Exhibit 3.2 PO
Details – Shipment Information.
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4.2.2 PRICE BREAK INFORMATION – ONLY APPLICABLE TO GBPA OR BPA

Price breaks may be defined for each line. These may include discounts for quantity or discounts for term dates.

IMPORTANT: For a description on each fields displayed, see Exhibit 3.3 PO Details – Price Break Information.

(1) Click on the Show All Details hyperlink to view all line details or click on the Show hyperlink to view a
specific line.

(2) The system will display the Price Break details, such as the Ship-To- Location, Quantity, Price Break,
Discount, etc. Verify the information entered is correct. For additional information, see Exhibit 3.3 PO
Details – Price Break Information.

4.3 ELECTRONICALLY ACCEPT OR REJECT PURCHASING DOCUMENTS – ONLY APPLICABLE

IF NOTIFICATION SUBJECT REQUIRES YOUR ACCEPTANCE

Once the Purchasing Document has been reviewed, the Supplier will proceed to acknowledge and accept or reject
it before the due date.

By accepting the Purchasing Document, the Supplier is communicating that they have reviewed the Purchasing
Document and accept the offer contained in the Purchasing Document, creating a binding agreement.

By rejecting the Purchasing Document, the Supplier is communicating that they believe that the Purchasing
Document does not reflect the agreed upon quote. If there is a discrepancy between the final quote and the
Purchasing Document; the Supplier can use a note to communicate this information to the buyer. The buyer will
either revise the Purchasing Document or cancel it.

IMPORTANT: The rejection of a Purchasing Document is not a new negotiation, a rejection is only executed to
correct a mistake made on the Purchasing Document regarding agreed terms and conditions.
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( 1 ) From the Actions dropdown menu, select the Acknowledge option. Then, click on the Go button. The

following screen will appear.
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( 1 ) As needed, click on the Cancel button to return to the previous Purchasing Documents Details screen.

IMPORTANT: The document status will remain the same. The Supplier will still have to accept or reject the
Purchasing Document. Start the steps again to perform this process.

( 2 ) Click on either the Accept Entire Order or Reject Entire Order button. The following screen will appear.

IMPORTANT:

 By accepting the Purchasing Document, the Supplier communicates that the Purchasing Document details are
correct and accepts the offer contained in the Purchasing Document, creating a binding agreement.

 By rejecting the Purchasing Document, the Supplier communicates that the Purchasing Document details
differ from the final agreed upon quote. The Supplier can indicate differences through a note. The buyer will
either revise the Purchasing Document or will cancel it.

( 1 ) Use the Note to Buyer field to communicate any issue to the buyer.

( 2 ) Click on the Submit button, then a confirmation message will appear in the PO Acknowledgement

Confirmation screen.

\
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( 1 ) Return to the main screen by clicking on the Return to Purchase Order Summary hyperlink

( 1 ) The Purchasing Document Status will have changed to Accepted or Rejected according to actions taken. The

buyer will receive an automatic email notification with this information.

4.4 VIEW RELATED TRANSACTIONS TO PURCHASING DOCUMENTS

On the Purchasing Document Details screen, Suppliers can also access transaction documents related to the

Purchasing Document such as receipts, invoices, payments, and shipments. From this screen Suppliers can also

manage deliverables associated with the Purchasing Document.

( 1 ) From the Actions dropdown menu, select the applicable option: Manage Deliverables, View Receipts, View
Invoices, View Payments, or View Shipments associated with the Purchasing Document. Then, click on the Go
button. The system will display the requested information.
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4.5 VIEW PURCHASING DOCUMENT HISTORY – REVISION DETAILS

The Orders tab allows Supplier to search for details regarding the revision history of a Purchasing Document, and

the ability to compare the current Purchasing Document in place with the previous versions.

( 1 ) Click on the Purchase History hyperlink.

( 2 ) Populate the search criteria to narrow the search or leave it blank to search for all Purchasing Documents,

then click on the Go button. The applicable Purchasing Documents will be displayed.

( 3 ) Optionally, click on the PO number hyperlink in the PO Number column to access the detailed information of

the Purchasing Document.

( 4 ) Click on the appropriate icon in the Compare columns to view the version changes for the selected Purchasing

Documents. Then, the PO Comparison Results screen will appear.

( 1 ) Compare the current Purchasing Document with the original version by clicking on the Compare to Original
PO button.

( 2 ) Compare the Purchasing Document in place with the previous version by clicking on Compare to Previous PO
button.

( 3 ) The Show All PO Changes section displays under which revision changes took place and in some cases which
sections of the Purchasing Document the changes were made.

( 4 ) The Field Altered column displays the specific changes made to the Purchasing Document.
( 5 ) Click on the Return to Order: Purchase History hyperlink to return to the previous screen.
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5 VIEW ORDERS RELATED TO SPECIFIC GBPA / GCPA

The Orders tab – Agreement Hyperlink allows Suppliers to access the Standard Purchase Orders related to a Global

Blanket or Contract Purchase Agreement, or Blanket Release related to a Blanket Purchase Agreement.

( 1 ) Click on the Agreements hyperlink.
( 2 ) Populate the search criteria to narrow the search or leave it blank to search for all agreements, then click on

the Go button. The applicable agreements (GBPA or GCPA or BPA) will be displayed.
( 3 ) The PO Number column shows the Purchasing Document number, as needed click on the PO number

hyperlink. Then, the Release table will be displayed showing the releases (or Standard Purchase Orders as
applicable) related to the Purchasing Document. Go to Step 5.1 Standard Purchase Orders Related To GBPA /
GCPA Or Blanket Releases Related To BPA.

( 4 ) The Revision column displays the number of times that a Purchasing Document has been revised. As needed,
click on the number hyperlink in the Revision column. Then, the PO Comparison Results screen will appear.
For additional information, see section above (4.5 View Purchasing Document History – Revision Details.)

( 5 ) The Effective – From Date column displays the date the agreement went in to effect.
( 6 ) The Effective – To Date column displays the date the agreement will expire.

NOTE: Actual contract expiration date is shown within the PO Details screen.

( 7 ) The Status column displays the Purchasing Document statuses. For additional information, see Exhibit 6. PO
Status.

( 8 ) In the Attachments column hover over, or click on the icon to see all of the documents attached to the
Purchasing Document including the agreement. For additional information, see section 4. View Purchasing
Documents Details.

( 9 ) Click on the Export button to export all the general information for the Purchasing Documents to an Excel

document.

5.1 STANDARD PURCHASE ORDERS RELATED TO GBPA / GCPA OR BLANKET RELEASES

RELATED TO BPA

Once clicked on the PO number hyperlink, then the Release table will be displayed showing the releases (or

Standard Purchase Orders as applicable) related to a specific Purchasing Document.
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EXHIBIT

1. EXHIBIT – PURCHASE ORDER VIEW COLUMNS

Suppliers may access Purchase Orders under this view.

(1) The screen defines the following columns:
 The PO Number column displays the Purchasing Document number. As needed click on the PO number

hyperlink to access the Purchasing Document details.
 The Rev (Revision) column displays the Purchasing Document Revision number. If revisions have not been

made to the Purchasing Document, it will display the number 0. As needed, click on the Revision number
hyperlink to view the changes / updates that have been made to the Purchasing Document.

 The Operating Unit column displays the CRC Operating Unit that issued the Purchasing Document.
 The Document Type column displays the document type. See Exhibit 4. Purchasing Document Type.

IMPORTANT: CRC arbitrarily assigns the applicable Document Types to contracts Depending on how to order and
invoice against the Purchasing Document (Contracts, Purchase Orders, Services Orders, Master Agreements, etc.)

 The Description column displays the contract name according to the CRC internal conventions:
o The Purchasing Document Type Acronyms (e.g. MSA – Master Service Agreement, CT – Statement

Commercial Terms, PO – Purchase Order, SO – Service Order, etc.),
o The Legacy Document Number if the Contract was created with the previous contract numbering

system. E.g. (MSA 21-4323), (SCT 2013-34), etc.
o The Scope of Work as stated in the Contract. E.g Gas Compressors for Project XX, Logging services for

Permian Basin, etc.

NOTE: If the SPO was created to support an invoice created against a GBPA through Supplier Charges, the
convention is INV Number XXXX.

 The Order Date column displays the date the Purchasing Document was issued.
 The Buyer column displays the name of the CRC buyer. As needed, click on the Buyer’s Name hyperlink to

view the buyer’s contact information.
 The Currency column shows the currency used in the Purchasing Document.
 The Status column displays the Purchasing Document statuses, see Exhibit 1.5 Purchase Order Status.
 The Acknowledge By column displays the due date the Supplier must accept or reject the Purchasing

Document.
 The Attachments column displays which documents have attachments included with the Purchasing

Document. Click on the Attachments icon to view the attachment. For additional information, see
section 4.1 - View Purchasing Documents Details.
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2. EXHIBIT – PURCHASE ORDER – HEADER INFORMATION

Purchasing document Key Information

Data Description

Section General - Information shared across all Document types

Supplier The name of the Supplier.

Supplier Site The Supplier Site issued for the Purchasing Document.

Address The Supplier’s physical address.

Buyer The name of CRC’s Supply Chain person responsible for the Purchasing Document on the
Commercial side. Click on the full name hyperlink to access the contact information.

Order Date The date the Purchasing document was issued.

Description The description of the Purchasing Document.

Status For a list of statuses along with the descriptions, see Exhibit 6 PO Status.

Note to Supplier This will display any notes, instructions or comments provided by CRC to the Supplier.

Operating Unit CRC’s operating unit where the Purchasing Document was issued.

Sourcing
Document

If applicable, the RFQ number will be displayed in this field.

Supplier Order
Number

If provided by the Supplier, the Supplier Internal Order Number will be displayed.

Purchasing
Document Type

For a list of purchasing document types, see Exhibit 4 Purchasing Document Type.

MSA/CPA
Reference

If the Purchasing Document references a Master Agreement, the Global Contract Purchasing
Agreement (GCPA) number that represents the Master Agreement will be displayed. To view
the Master Agreement, use this number to search and access the Document.

Proponent –
Contract Owner

The name of the Non Supply Chain Person who is also responsible for the Purchasing
Document on the operational side.

Physical Location CRC Internal Contract Filing Location

Revision Category CRC internal revision type classification. (New Contract, Amendment, Update, etc.)

Contract Category CRC internal service/material category classification.

Section General - Information specific for GBPA, GCPA, BPA
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Purchasing document Key Information

Data Description

Contract
Expiration

Actual contract expiration date.

Open For
Invoicing Flag??

If system displays Yes, this allows Suppliers to continue submitting charges after the
agreement is closed.
If system displays No or is left blank, this means the agreement has been disabled from
allowing Suppliers to submit charges after the agreement is close.

Section General - Information specific for SPO and BR

Incoterm If international commercial terms are applied to the agreement, it would be displayed in this
field.

Incoterm Place Name of the location.

Freight Forwarder Supplier CRC uses (international) to deliver materials.

Port of Entry Location by which materials may enter a country.

Mode of
Transportation

Method for transporting materials.

Clearing Agent Individual responsible for inspecting and clearing materials.

Effective Start
Date

The date the document is signed.

Effective End
Date

The date the document is scheduled to expire.

Country of Origin Where the materials are coming from.

Section Terms and Conditions

Payment Terms Terms and conditions Supplier and CRC agreed to.

Carrier Currently not in use.

FOB Destination, Origin, In Transit Location

Freight Terms Terms and conditions Supplier and CRC agreed to.

Shipping Controls If shipping controls are applied to the agreement, it will be displayed under this field.

Section Ship-to Address

Address Location of CRC facility for shipping/delivery of goods or services. Purchasing Document
lines can indicate different Ship-to-locations.

Section Bill-to Address

Address Instructions for submitting invoices. For paper invoices, this field will indicate the physical
CRC address invoices must be mailed to. In the case of electronic invoices, this field will
indicate which system the invoice should be submitted to (iSupplier Portal or ADP).
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3. EXHIBIT – PO DETAILS

3.1 PO DETAILS – LINE INFORMATION

PO Details for Line Information displayed below:

Line Specific Information

Columns Description

Line Type Might be listed as Goods, Services, and Price on Demand. For list of line types along
with the description for each of the line types, see Exhibit 5 – Line Types.

Item/Job CRC’s internal item number.

Supplier Item Supplier’s internal item number.

Description CRC’s internal item description.

UOM Unit of measure.

Qty Agreed quantity ordered – Applicable to Releases or Standard Purchase Orders. Qty is
not applicable to the following Line Type Items: Amount Based, Sales Tax, Tax Other,
and Freight line types.

Price Base price. This amount will not change.

Amount Quantity ordered multiplied by the agreed price – Applicable to Blanket Releases or
Standard Purchase Orders.

Note to Supplier Note from CRC provided to Supplier.

Status Status of the Line. Open, Closed, Finally Closed, etc.

Start Date Date that PO line was open.

End Date Date that PO line expired.

Attachments Attachments related to the Purchasing Document lines with additional information

Reason If a line is Closed or Finally Closed, a note is displayed to the Supplier providing reason.

Contract Number Global Contract Purchase Agreement Number – Only Applicable to Standard Purchase
Orders
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3.2 PO DETAILS – SHIPMENT INFORMATION

PO Details for Shipment information displayed below:

(1) Click on the Expand All hyperlink to display the Shipment table applicable to the lines. The table will
include a line for each individual shipment requested.

Shipment Information

Data Description

Shipment How many shipment lines were created within a PO Line.

Ship-To Location Where material is being shipped.

Qty Ordered (Quantity Ordered), Received (Quantity Received) or Invoiced (Quantity Invoiced)

Amount Ordered (Amount Ordered), Received (Amount Received) or Invoiced (Amount Invoiced)

Promised Date Vendor agrees to ship out material.

Need-By Date When Buyer needs the material by.

Payment Status Status of the payment.

Status Status of the Line. Open, Closed, Finally Closed, etc.

Supplier Line PO Line Number of the agreement.

Split Line split by quantity, inventory or ship to location. Split is based on shipment lines.
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3.3 PO DETAILS – PRICE BREAK INFORMATION

PO Details for Price Break information displayed below:

(1) The Price Breaks table applicable to the lines will be displayed.

Price Break Information

Data Description

Shipment How many shipment lines were created within a PO Line.

Ship-To Location Where material is being shipped.

Qty For a GBPA this would be the amount that needs to be ordered in order for the price
break rate to take effect.

Price Break The Price Break based on what was agreed in the GBPA.

Payment Status Status of the payment.

Status Status of the Line. Open, Closed, Finally Closed, etc.

Supplier Line PO Line Number of the agreement.

Discount (%) Percentage applied for a specific period based on the Price Break agreed in the GBPA.

Start Effective Date Start of the price break discount.

End Effective Date End of the price break discount.

Split Line split by quantity, inventory or ship to location. Split is based on shipment lines.

Reason If a line is Closed or Finally Closed, a note is displayed to the Supplier providing reason.

Attachments If attachments included at Shipment line level, it will be displayed in this column.
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4. EXHIBIT – PURCHASING DOCUMENT TYPES

There are 5 different Purchasing Document types. Each Purchasing Document has a specific purpose and usage, as

described below.

Purchasing Document Types Description

Global Contract Purchase
Agreement (GCPA)

 Used to specify terms and conditions under which goods and/or services
will be purchased without indicating the specific goods and/or services that
will be purchased. They could be set to be transactional across several CRC
Companies (Qatar, Colombia, etc.).

 To place the actual order that defines items, quantities, prices. etc., CRC has
to issue Standard Purchase Orders against it. The GCPA reference number
can be viewed in the SPO lines.

 In the case of Master Agreements, they are also represented as GCPA but
they are not transactional, CRC cannot issue Standard Purchase Orders
against them.

Global Blanket Purchase
Agreement (GBPA)

 Used for purchasing materials or services when the description of the
goods and/or services are known but the delivery schedule of the goods
and/or services is unknown. Global Blanket Agreements specify negotiated
prices (Price Books) before the items are actually purchased and for a set
period of time. They could be set to be transactional across several CRC
Companies (Qatar, Colombia, etc.).

 To place the actual order, CRC has to issue Standard Purchase Orders
against the specific GBPA. The GBPA reference number can be viewed in
the SPO lines.

 Alternatively, if allowed, Supplier could also create Supplier Charges
(invoices/field tickets) against GBPAs through the iSupplier Portal. The
system will programmatically create a SPO against the GBPA to support the
transaction.

Standard Purchase Order (SPO)

 Used for one-time purchases of materials or services when the description
of the goods/services, pricing, quantities and delivery schedule are known.

 As indicated above, the SPO lines may reference to a Global Blanket or
Contract Purchasing Agreement if applicable.

Blanket Purchase Agreement
(BPA)

 Used for purchasing materials or services when the description of the
goods and/or services are known but the delivery schedule of the goods
and/or services is unknown. Blanket Agreements specify negotiated prices
before the items are actually purchased and for a set period of time. They
are only transactional by one specific CRC Company (Qatar, Colombia, etc.).

 To place the actual order, CRC will issue a blanket release against the
specific BPA. The Blanket Release Number is the BPA number – Release
Number (i.e. 21000032133-4, etc.).

Blanket Release (BR)
 Used for one-time purchases of materials or services against a specific BPA

when quantities and delivery schedules are known.
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5. EXHIBIT – LINE TYPES

There are 8 PO Line Types that might be listed in the Pricebook of an agreement. According to the PO Line Type

applicable to each line item in the Pricebook, the system displays this information. Each PO line type has a specific

purpose and usage, as described below.

Type Description

Goods Material charges that should be within the scope of work of the Agreement. Unit of measure
and base rate are populated per Pricebook information.

Services Service charges that are within the scope of work of the Agreement. Unit of measure and
base rate are populated per Pricebook information.

Price on Demand Material/Services/Charges that should be within the scope of work of the Agreement, but are
not specifically defined in the Pricebook.

Amount Based

Services

Service items where the total amount to be paid is known but is not possible to define a unit
of measure and a Unit Rate.

3rd Party Services or Materials provided by a 3rd party (subcontractor) to be invoiced based on the 3rd
party invoice value.

Reimbursable Expenses to be reimbursed based on expense report. The expenses should be within the
scope of work of the Agreement but they are not specifically defined in the Pricebook.

Sales Tax A tax added to Services or Materials.

Tax Other Taxes that are not sales tax, i.e. environmental taxes.

Freight Transportation costs to be paid if they are segregated from the service/material rate. At the
Buyer’s discretion, this type of item may or may not be included in the Pricebook.

6. EXHIBIT – PO STATUS

There are 8 Purchase Order statuses. The table below displays the different PO Statuses:

Purchasing

Documents Statuses

Description

Open The Purchasing document is valid and still open for receipt.

Requires

Acknowledgment

The Supplier must acknowledge the Purchasing Document. The Purchasing Document is
valid and open for receipt.

Accepted The Purchasing Document is valid, open for receipt, has been acknowledged and accepted

by the Supplier.

Frozen The Purchasing Document is on Hold for some reason. Contact the Buyer who issued the

Purchasing Document for further information.

Closed The Purchasing Document is complete and is still available for invoicing.

Finally Closed The Purchasing Document is complete and is no longer available for invoicing.

Cancelled The Purchasing Document has been cancelled and is no longer needed.

Buyer Change

Pending

The Purchasing Document is being revised by CRC. After the new revisions are complete,
the document will be given a new revision number documenting the changes
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